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Introducing Report  Builder  
 

You can use Report Builder to design reports. This chapter describes: 
 

Å     Our approach to building reports. 

Å     Some of the reports you can build. 

Å  Designing report templates you can use repeatedly with different data sources. 

 

 

Building reports  
 

Use Report Builder to design and generate reports consisting of data from various sources. With Report Builder, 

you create report templates to design, test, print, and manage reports. 
 

When you save a Report Builder file, you actually save an encoded representation of all the objects, their formats, 

and their locations on the report template. As you edit the template, Report Builder writes the representation in the 

background and saves the changes to file when you save the report template. 
 

Report Builder is different from other report generators because it is not tied to a single data source. Instead, it can 

accept and use data from SQLWindows and other applications. 
 

Development tools such as SQLWindows can help you create complex report applications using function calls and 

messages. Report Builder asks for rows of input data, and your application provides the data. Throughout the 

procedure, you can interactively display, change, and print the report. Alternatively, Report Builder can directly 

connect to a database, issue a query, and fetch the rows as data for the report all by itself. 
 

Application developers can view or modify a reportôs design during designtime, and users view the report at 

runtime. You modify the report design directly through the use of the Report Builder designer workspace, or 

programmatically through the Report Builder interface to development tools. 
 

For tutorials demonstrating how to build reports with SQLWindows and Report 

Builder, read Chapter 7. 
 

Types of repor ts 
 

With Report Builder, you can create many types of reports. Among these are: 
 

Å Multi-column (mailing labels) reports. 

Å Form letters. 

Å Break group summary reports. 

Å Two pass totals reports. 

Å Input cross tabular reports. 

For more, read Chapter 7, Report Builder Tutorials 

 

Multi -column reports  
 

Use multi-column reports to create a report with two or more columns across the page such as mailing labels or 

telephone directories, and various other reports where information can be broken into narrow columns. 
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Form letters  
 

A form letter lets you create a template that contains most of the text in the body of a letter. However, some 

information, like the customer name must be unique to each letter. Report Builder integrates the unique information 

with the repeated information to create a personalized form letter. 
 

Break  group  summary  reports  
 

Report Builder can create templates for reports that subdivide data into logical units called break groups. Often you 

want data summaries by these groups. You can sort data in a way that best fi ts your report. 
 

For example, a company may have regional offices, departments within each region, and one or more managers 

within each department. When creating a break group summary report, the company could logically sort these 

groups of data in order of regions, departments, and managers, that is, from the larger group to the smaller group. 
 

Report Builder lets you summarize each break group. When you define break groups, it automatically adds the break 

group block captions for the break group where you can add a title for the break group in the header and a summary 

in the footer. 
 

Two pass tota ls reports  
 

Two-pass totals, also known as input totals, are another form of input data that Report Builder can use. With two pass 

totals, Report Builder pre-calculates specified totals or other aggregate types of calculations, and provides the result 

as input to your report. All input totals are numeric variables that can be assigned to a field, or used by a formula in 

Report Builder. 
 

With two pass totals reports, Report Builder can pass the data twice to the report. In the first pass, Report Builder 

calculates the input totals and in the second pass it formats the report, putting those totals wherever you want to see 

them. The advantage over a one pass report is that with two-pass totals are not restricted to appearing directly after 

the data. 
 

Input  cross tabular  reports  
 

Use crosstab reports to gather cross tabular statistics on your reportôs input rows. The crosstab feature summarizes 

the information your report receives. 

 
Cross tab reports generate a two dimensional matrix of numeric data based on the categories and data you provide. 

The size of this matrix depends on the number of unique occurrences of each column and row category you use in 

your cross tabs definition. 
 

You can have from 1 - 8 row categories and from 1 - 8 column categories in your crosstab. The greater the number 

of row and column categories, the larger and more complex your crosstab matrix will  be. 
 

Report templates  
 

To create a report with Report Builder, you must build a template. Your template contains all the instructions 

needed to format and display the data provided by other applications or database queries. The input data Report 

Builder uses is not stored with the template and must be made available by an external source. 
 

Report Builder simplif ies the process of creating templates by providing a graphical interface that lets you use 

keyboard commands or a mouse to build fields, lines, boxes, blocks, and break groups. You can import graphic 

images and format all report elements using a variety of font styles, sizes, borders, and alignment. 
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Parts of a report  template  
 

As you create and design your report template, you need to understand the basic elements of a report. A report is 

made up of various components which control how and where the Report Builder presents and stores the data. 
 

Elements of a Report Template 

Block Groups Lines 

Block Group Captions Fields 

Headers Boxes 

Footers Pictures 

Break Groups Background Text 

Detail Block Graphs 

Input Items Crosstab reports 

 

Block groups are made up of a paired header and footer, and their related lines and associated fields, pictures, and 

boxes. Report Builder generates a block group for the following headers and footers: 
 

Report Header Page Header Break Header 

Report Footer Page Footer Break Footer 

 
 
 
 
 
 
 
 
 
 

Field 
 
 
 

Background 

Text 
 
 
 
 
 
 
 
 

 
Block Group Captions appear in a rectangle attached to the block group. These captions are the headings or 

titles of each block group. 
 

Headers are optional and come in three types: report, group, and page: 
 

Å Report Headers appear only once in the report (at the beginning) and contain a reportôs title. 

Å Page Headers contain messages, page numbers, references, page totals, and so on. In preview mode, they 

appear once at the top of every page except the first page where the report header appears. If no report 

header is defined, the page header also appears on the first page. 

Å Group Headers appear before the first line of a group of records when you define them and prints each 

time a break group changes. 
 

Footers are optional and come in three types: report, page, and group. 
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Å Report Footers often contain report totals and summary information. 

Å Page Footers are located on the bottom margin of each page and typically contain the report page number, 

page totals, and the date. 

Å Group Footers appear after the last line of a group of records if you define group footers, and are printed 

each time a new break group changes. 

Break Groups group information into subunits such as region or department. Break groups are also used for 

subtotaling and pagination. Each break group must have an input item that tells the report when to break as the item 

changes. 
 

Detail Blocks print information from a group of individual rows (called a block) showing the data as it is sorted 

from the database. Report Builder has only one detail block per template. 
 

Input Items are the individual data elements in a report. An input item is the same as a data field in a record, or a 

column item in a database table. 
 

All  the input items together make up an input row, in the report template. Input items can also come from different 

sources and occur at different frequencies, such as once in a report header or more frequently in detail blocks. An 

input item can contain data such as a name, comments, a birth date, or a dollar amount, but requires a name and a 

data type. 
 

As SQLWindows, or a query, passes input items from a data source to a report template, it moves the data as input 

items. For example, if  you link a table to your report template, the columns in the table become input items in the 

report template. 
 

Lines are added to block groups and detail blocks with the line tool in the Tools menu. Lines can either be blank or 

contain objects such as fields, boxes, pictures, or background text. You can add various borders to lines. 
 

Lines can have features such as page break before, column break before, and blank line suppression. Page break 

before creates a new page before the line prints. Column break before does the same thing with columns. Blank line 

suppression lets you hide blank lines from your printed output. 
 

Fields contain or define the textual information of a report. Fields can contain different types of information 

including text, input items, or formulas. Fields can also have a fixed or dynamic width and can be enclosed in 

borders. 
 

Boxes are objects you create using the box tool. Use the box tool to draw a frame around one or more fields, an 

entire report block, or a group of lines. Once a box has been created, you can re-size it, or move it to any location in 

the same block. 
 

Pictures can contain graphics and long text (imported as an object). Once you draw your picture object, you can 

re-size it and move it to any location within the same block group. 
 

Background Text contains fixed text only. You can use background text to: 
 

Å Label the objects in your report template. 

Å Write column headers for the input items in your detail block. 

Å Write report and page headers and footers. 

You can format background text with all character formats available in the report ruler in the same manner that you 

format report fields. (Read more about the report ruler in Chapter 3.) 
 

Graphs opens a default graph that you can modify by using its tool palette. 
 

Crosstabs opens a crosstab wizard to help you create and set up a crosstab report template. 
 

Runnin g existing repor ts 
 

Your applications can call the Report Builder executable to launch reports that have already been designed and 

saved. A series of command-line arguments supply enough information to run the report without user intervention. 
 

The name of the executable varies with the version of Team Developer. Presently it is named REPBI63.EXE. 

Command-line arguments include: 
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Å /d or -d: Database name 

Å /u or -u: User name 

Å /a or -a: Database password 

Å /p or -p: Printer name 

Å /pt or -pt: Print-to name 

Å /h or -h or /? or -? or /help or -help: Presents a help screen showing argument usage. 

Å /ini : Configuration file name. Indicates which copy of the configuration file (often named SQL.INI)  

should be used for database connectivity information. Optional. 
 

Most arguments are not case-sensitive, but "p" and "pt" are case-sensitive. You can place a blank between the 

argument tag and the value, but it is not required. For example, "/disland" and "/d island" will both work. If  the 

report uses a database query, and you do not supply all the arguments necessary to connect to the database,  a 

connection dialog will  pop up when the report begins and the user will  need to complete the database name, user 

name, and/or password. 
 

Examples of running  Report  Builder  from  a command  l ine  
 

REPBI6 3.EXE /ini "c : \ my doc uments \ myconfig. i ni"  

 

Starts Report Builder with a blank "No report" workspace. Uses file myconfig.ini for database connectivity 
information. 

 

REPBI6 3.EXE " %USERPROFILE%\ Team Developer  6. 3\ sample s\ formltr . cqt"  

 

Starts Report Builder, loads report formltr.cqt, then pauses and prompts the user for database user ID and password., 
then executes the report and shows it in a separate window. The user is prompted because there is not enough 
information supplied for Report Builder to make the database connection on its own. 

 

REPBI6 3.EXE " %USERPROFILE%\ Team Developer  6. 3\ sample s\ formltr . cqt" /d  island / u 

sysadm  /a sys adm 

 

Starts Report Builder, loads report formltr.cqt, then executes the report and shows it in a separate window. 
 

REPBI 63.EXE /p " %USERPROFILE%\ Team Develop er  6. 3\ sample s\ formltr . cqt" /u  sysadm / a 

sysadm  

 

Starts Report Builder, loads report formltr.cqt, then prints it to the current default printer. 
 

REPBI6 3.EXE /pt " %USERPROFILE%\ Team Develo per  6. 3\ sample s\ formltr . cqt"  "S nagIt  6"  

"SnagIt  6 Printer"  "Snag I t6"  /d  island / u sysadm  /a sysa dm 

 

Starts Report Builder, loads report formltr.cqt, then prints it to the printer name, printer driver, and printer port that 
are specified in the three arguments following the report file name. 

 

Where to get more info rmation  
 

You can find more information on building reports from the Gupta online help. The online help provides procedures 

on how to use Report Builder and detailed descriptions on how to use the keyboard, mouse, commands, functions, 

dialog box options, icons, and screen regions. Press the F1 key to access online help. 
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Creating Repor ts 
This chapter introduces you to the report data that Report Builder uses to populate the templates you design. This 

chapter describes: 
 

Å Report data sources. 

Å Importing Quest files. 

Å Defining a query. 

Å Input items, variables, totals, and crosstabs. 

Å Procedures for entering input data into report objects. 

 

Report da ta sources 
 

Before you can create a new report, you must specify a source of data for the report. Report Builder can accept data 

from several different sources, including: 
 

Å An integrated query. 

Å Gupta SQLWindows or other applications. 

Å Quest files (.QQT). 

 

Data source requirements  
 

When you do not use an integrated query, you must provide the following information about each input item in the 

input row: 
 

Å The name of every input  item. Use of spaces and special characters are limited. The underscore is the 

only special character that is valid. Spaces in the middle of character strings are invalid, unless you use a 

double quote around the name that  contains the space. Trailing or leading spaces are automatically 

striped out. 

Å The data type of each input item. It can be a character string, number, a date/time value, or an object. 

Å The order in which input items are organized in the input row. 

Å The sort order of your input rows. This sets the break group order of your report. In addition, you must 

presort all source data in break group order before you provide it to Report Builder. 
 

Using an integrated  query  
Within Report Builder, define a database query, execute it, and the results of the query populate the report. 

 

Using SQLWindows  as a data source 
 

SQLWindows developers or developers using other similar applications need only create applications that pass data 

to the report template; they do not need to create or format a report within the application. 
 

SQLWindows interfaces with Report Builder by: 
 

Å Providing rows of data (input rows) for you to format and use in the report templates. 

Å Providing report input variables for you to use. 

Å Using functions to create, view, print, or close your reports. (Read the SQLWindows Function Reference 

manual or the Gupta Team Developer online help for more information on functions.) 
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Because Report Builder is not dependent on a single source of input data, it is possible for you to develop and test 

your report templates and SQLWindows applications independently. 
 

Import ing Quest fi les 
 

You can import your Quest fi les into Report Builder to use as report templates going forward. The following 

procedures show you how to do this. 
 

Open a Quest Query 
 

1.    To open a Quest Query Template fi le, select Open from the File menu in Report Builder.  

The Open Report dialog appears. 
 

 
 

2.    In the Files of Type field, select Quest Query files (*.QQT ). 
 

3.    Browse to your query fi le, highlight it, and click Open. 
 

Report Builder will  execute the Query and display a default report. If  you have a Quest Report file that was 

linked to the query, you can open it now. 

 

Open a linked Quest report 
 

1.    Select Import  Template from the Edit  menu. The following dialog appears: 

 
 

2.    Click No if you do not wish to save the default report. The Reset Detail Fields dialog box appears. 
 

 
 

This box is warning you that you may need to rematch the data columns of the query with the input items of 

the report template. 
 

3.    Click Yes. The Save Report File dialog appears. 
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4.    Click No unless you want to continue working with the Default Report. The Open Report dialog appears. 

 

 
 

5. In the Files of type field, select Repor t Template Files (* .QRP) and select your report template so the fi le 

name appears in the File name field. 
 

6.    Click Open. The report template appears. 
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Defining a query  
 

To define a query is to select one or more database tables and then specify how the data will  be displayed. You must 

define a query before you can create a report. 
 

The Define Query property pages allow you to define the queries for your report. You select the Define Query 

property pages when you create a new report (File, New), or when you wish to define a query from an existing 

report (Repor t, Define Query). 
 

These are the Define Query property pages as they appear initiall y. 
 

 
 

 
To select a property page, click on the tab at the top of the property page. There are six property pages that you 

can use: 
 

Á Source select tables or views. 

Á Conditions defines the conditions that must be met for the data to be included in the result set. 

Á Sort  defines how the data will  be sorted in the report. 

Á Group By defines how the data will  be grouped in the report. 

Á Group Conditions defines the conditions which decide how the data will  be grouped in the report. 

Á SQL displays the SQL that will  be generated to create the query. 

Á Result displays the actual data that will  be returned. 

 

Source property  page 
 

Use the Source property page to select the table(s) or view(s) for your query. 
 

The source property page initially shows the available servers (e.g., SQLBase, Oracle, Sybase, Informix, etc.) on 

the left-hand side of the page. This is the Source property page. 
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To select a table 
 

1.    Double-click on the desired server. 
 

The databases associated with the selected server appear. 

Note:  If you do not see the database you wish to connect to, you may need to add it to the list manually. To do 
this, right-click on the desired server. Select Add to List... from the context menu. The Add to List dialog box 
appears. Use the Server tab to add a new server to the list by name (this applies only to SQLBase database 
servers, or DB servers if you are using Gupta SQLHost to connect to DB2). Use the Database tab to add a new 
database to the list by name. 

 
2.    Double-click on the desired database. 

 

The Connect To dialog appears. 
 

3.    Enter a User Name and Password on the Connect To dialog and click OK . 

Note: Before you can select tables from the ISLAND database, you must log in. Use sysadm as the login name 
and password as shown below. 

 

 
 

The tables and views associated with the selected database appear under the database. 
 

4.    Double-click on the desired table(s) or view(s), or drag the desired table(s) or view(s) over to the right-hand 

side of the screen. 
 

You can select multiple tables or views. When you select more than one table or view, the links between the 
tables or view are displayed. If  you wish to change the links between the tables or views, click on the button 
with the equal sign (=). When you select a table or view, the columns that can appear within the table or view 
are displayed. 

 

5.    Select the columns that you wish to appear in your report. 
 

All  the columns that can appear within the selected table are displayed. You can select/deselect a column by 
clicking the box next to the column A check mark appears next to the columns that will  appear in the report. 
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Conditions  propert y page 
 

Use the Conditions property page to define the conditions that must be met for data to be included in your reportôs 

result set. Use each line of the table to enter a condition that will  restrict the results when the rows for the table are 

fetched from the database. 
 

This is the Conditions property page. 
 

 
 

To define a condition 
 

1.    Select a Column or Formula. 
 

To select a column, place your cursor in the Column/Formula field and click the left mouse button. A list of the 

available columns associated with the selected table are displayed. To select a formula, click the Formulas 

button, select the desired formula from the Formula Editor screen, and click OK . 
 

2.    Select an operator. 
 

To select an operator, place your cursor in the Op field and click the left mouse button. A list of the available 

operators is displayed. 
 

3.    Enter a value 

You can either enter a value or double-click on a cell in the Values column to access the Condition Value 

screen. The Condition Value screen helps you to select a value for the condition. 

Note:  Use AND or OR to group multiple conditions together. 

Sort property  page 
 

Use the Sort property page to specify how you want to sort the data in your report (that is, the order in which rows 

appear when fetched from the database).  

 

This is the Sort property page 
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To define how you wish to sort the data 
 

1.    Select the columns and/or formulas by which you wish to sort. 
 

To select a column, place your cursor in the Sort By field, click the left mouse button, and select a column 

from the list that appears. To select a formula, click the Formulas button, select the desired formula form the 

Formula Editor screen, and click OK . 
 

2.    Specify whether the data should be sorted in ascending or descending order. 
 

To select how the data will  be sorted, place your cursor in the Asc/Desc field, click the left mouse button, 

and select either Asc or Desc. 

Group By property  page 
 

Use the Group By property page to define how to group the data in your report. The Group By property page allows 

you to create a summary query. Typically, you will specify a Group By when you want to summarize data. Select 

the column(s) and/or formula(s) by which you wish to group the data. 
 

This is the Group By property page. 
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To select a column 
 

Place your cursor in the Group By field, click the left mouse button, and select a column from the list that appears. 

 

To select a formula 
 

Click the Formulas button, select the desired formula from the Formula Editor property page, and click OK . 
 

Note: Using the Group By property page may change the columns and formulas that you have already added to the 
query. 

 

SQL property  page 
 

The SQL property page displays the SQL that will be generated to create the query. This is the SQL property page. 

 

Select the values you wish to include in the SQL by clicking next to one of the following options under the Value 

Pick List Options section of the page: 
 

Å List no database values 

Å List all unique values 

Å List a maximum of 

If  you wish to include unique rows only, click the box next to Include unique rows only under the Query Results 

section of the property page. If you wish to copy the SQL to the clipboard, select the data under the SQL Statement 

section of the property page and click the Copy to Clipboard push button. 

 

Result prop erty  page 
 

Based on the information you have entered in the other property pages on the Define Query screen, the Result 

property page displays the actual data that will  be returned in your report. 
 

This is the Results property page. 
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Input da ta types 
 

The data Report Builder accepts is called report inputs. You can use a variety of input data to populate your report 

templates. These variations include: 
 

Å Input items 

Å Input variables 

Å Input totals 

Å Input crosstabs 

Each kind of report input listed above provides a different type of information for the report to use. 
 

Input Items are similar to a data field in a record or a column in a database table. The combined input items make 

up an input row. Report Builder processes one input row at a time. The input row is updated after every input fetch. 

You must define the name and data type of each input item received by your report and enter the input items in the 

same order they appear in your input row. 
 

Input Variables are values set in Report Builder by your application. Unlike input items, input variables do not 

need to be updated with each input fetch. 

 

Input Totals let you display aggregate statistics in your report fields. Input items or formulas are evaluated to 

return an aggregate value. This aggregate value is used as an input to the report. All  formulas are evaluated and 

statistics accumulated immediately after each input row is fetched. You can calculate sums, averages, percentages, 

and so on, before or during report generation with input totals. 
 

Input Cross Tabs is an advanced report feature that you can use to gather cross tabular statistics on the report 

templateôs input rows. All category items are evaluated and statistics accumulated immediately after each input row 

is fetched. The resulting matrix is used as input to your report. 

Input  Items  
Input items define the data elements used by the report. Input items are one of the following four main data types: 

Å A string, that is, any combination of alphanumeric characters. 

Å A number, being numerical value of up to 22 digits. 

Å A date or time, which has a three-part data value (dd/MM/yy or hh:mm:ss). 

Å An object, meaning a picture. 

Note: All input rows must be sorted in break group order before you provide them as input data to Report Builder. If 
you add, modify, or delete input items from your report, you must also change the result set of the corresponding 
linked application so that your report can receive a matching set of data. 
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Defining input items 

Every item in the input row must be assigned a unique name Report Builder can use to refer to it. You must define 

the input item names in the same order they appear in the input row. 
 

Before using the Input Items command in the Report, Format menu, you must know the format and layout of 

your input row. To define your input items, you need the following information: 
 

Å A name for each input item. (All  input items in the input row must be listed, even if  you do not plan to use 

all  of them in your report template.) 

Å The data type (String, Number, Date/Time, or Object) of each item. 

Å The order in which the input items appear in the input row. 

 
Entering input item names 

 

This is one of the first procedures you must perform when creating a new report. Enter input item names for each 

report that receives and uses data from an external source, that is, from a database or an application program. 

Note:  If you have created or imported a query, Report Builder automatically generates the report inputs for you. 

Enter the names of all the input items that make up your input row and enter the input items in the same order they 

appear in the input row. Your report uses this information to read the data from the data source. 
 

Refer to the naming rules on page 2 of this Chapter as a guide to naming your input items. 
 

1.    Right-click on the input items node in the left pane and choose New. 
 

This dialog box lists all of the currently defined input items. If  you have not defined the input items, the Input 

Name text box is empty. 
 

 
 

2.    Enter the input item name in the Input  Name box. 
 

3.    Select the data type of the input item. 
 

You can choose Str ing, Number, Date/Time, or Object. 
 

4.    Click New to add the input item in the Input Names list box. 
 

5.    Repeat Steps 2 through 4 for all the remaining input items in the input row. 
 

You must enter the input items in the order they appear in the input row. 
 

Use the Up and Down arrow buttons to change the order of the input items as necessary. 
 

6.    Click OK to apply all changes to the report and to close the dialog box. 
 

Click Cancel to close the dialog box without saving any changes. 

 

Input  variables  
 

Input variables are another type of input data that your report uses. Unlike input items which are passed with every 

report fetch, input variables are passed to your report only when they are set by the application. For example, you 

can use input variables to pass information like a graphic image to your report template each time a break group 

footer is printed. 
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Like input items, input variables must be one of four data types: 
 

Å String 

Å Number 

Å Date/Time 

Å Object 

SQLWindows applications use input variables in the report to send information to, and return information from the 

report engine. SQLWindows does this by using functions to modify your report. 
 

Refer to the SQLWindows Function Reference for information about the SalReport functions. 

 

Defining input variables 

Use the following procedure to define the input variable values your SQLWindows application passes to your 

report. 
 

Defining input variables for your report 
 

1.    Right-click on input variables in the left pane. 
 

Report Builder opens the property page with a list of all defined input variables. The list is empty if  you did not 

define any input variables. 
 

 
 

2.    Enter the input variable name in the Variable Name text box. 
 

The names you assign to input variables must be unique among Items, Variables, Totals, and Cross Tabs. 
 

3.    Select the data type of the input variable. 
 

You can choose from Strin g, Number , Object, or Date/Time. 
 

4.    Click New to add the input variable name in the Vari able Names l ist box. 
 

5.    Repeat Steps 2 through 4 for any other input variables you want to include. 
 

6.    Click OK to apply all changes and exit the dialog box. 
 

Click Cancel to exit the dialog box without saving any changes. 

Input  totals  
Report Builder pre-calculates specified totals or other aggregate types of calculations, and provides the result as 

input totals to your report. Input totals can also be two-pass totals. All input totals are numeric variables assigned to 

a field, or used by a formula in your report template. 

Use the Format Totals dialog box to define, modify, and delete the input totals in your report. You can assign 

input totals to fields, just like input items and input variables. 

In the Define Total dialog box, set the pre-process flag ON to have the totals calculations performed before your 

report output is generated. If you do this, the report data is passed once to the report engine and processed twice 

by the report. The first pass calculates your report input totals, the second pass formats the report. 

Alternatively, you can set the pre-process flag OFF. If you do this, the report engines calculates the totals on an 

on-going basis as the report data is fetched for the first and only time. 
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Defining input totals for your report 
1.    Right-click on Input Totals in the left pane. 

 

 
 

2.    Click New to create a new input total using the Format Totals dialog box. 
 

3.    Enter a name for your new input total. 
 

The name cannot have spaces in it. The only special character that is allowed is the underscore. 

4.    From the Formula drop down list box, select the item you want to evaluate. 
 

The items in the Formula drop down list box must first be defined. If  you do not define a formula, it shows only 

inputs. The item in this list box can be any numeric formula or an input item. 
 

Pressing the Formula push button opens the Formula Editor  dialog box where you define formulas. 
 

5. Select the type of statistic you want to calculate from the Statistic drop down list box. 
 

Each input total can evaluate one statistic. Select Value if  you want to display the last value of the item you 

selected in the Formula list box. 
 

6.    Choose when you want to zero your totals from the Restart Event drop down list. 
 

This list box shows all the break group items. Report Builder restarts totals calculations whenever the selected 

break group changes. 
 

7.    Repeat steps 5 to 9 to create all your input totals. 
 

8. Click the Pre-Process check box if you want Report Builder to calculate your totals before it formats your 

report. 
 

Use this if  you plan to display break group totals at the beginning of a break group (for example, in the break 

group header) rather than at the end of the break group. By setting Pre-Process ON, you ensure a valid total 

display at the beginning of the break group. 
 

9.    Close the open dialog boxes to return to your report template. 
 

Adding input totals to your template 

1.    Drop fields in the report template for each one. 
 

Drop the fields in appropriate locations in your template. If  you have totals for a certain break group, you can 

draw the fields in the appropriate header or footer blocks. 
 

2.    Assign the input totals to each field. 
 

Right click on the field and select Properties then use the Edit  button to assign the total to the field. 
 

3.    Select Report, Preview to view your report with the input totals. 

Input  crosstabs 
 

Use the input crosstabs feature to gather cross tabular statistics on your report input rows and to summarize the 

information your report template receives. 
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The Cross Tabs Data Collector generates a two-dimensional matrix of numeric data based on the categories and 

data you provide. The size of this matrix depends on the number of unique occurrences of each column and row 

category you use in your crosstabs definition. 
 

You can have from 1 to 8 row categories and from 1 to 8 column categories in your crosstab report. The greater the 

number of row and column categories, the larger and more complex your crosstab matrix is. 
 

You must identify each crosstab with a unique name. A report can contain any number of crosstabs. 
 

Formatting your crosstab matrix 

Your crosstab computations result is a two-dimensional numeric matrix that you assign to any field in your report 

template. You must set Dynamic L ine Wrapping ON for the field containing your input crosstab matrix since you 

cannot determine the size of your crosstab matrix until  all calculations are complete. See the Format Fields 

command in the Report Builder online help for more information on this feature. Use the crosstab wizard to format 

your crosstab matrix. 
 

Crosstab Formula Editor functions 

Get information on the number and names of the rows and columns in your crosstab matrix by using the following 

report functions in the Formula Editor. 
 

XTabGetColHeadings returns a tab-separated string of column names for the crosstab matrix. Each column name 

is a unique combination of the values returned by your column categories. You need to use this function to build a 

label for each combination of column categories in your crosstab. 
 

XTabGetRowHeadings returns a tab separated multi-line string of row names for the crosstab matrix. Each row 

name is a unique combination of the values returned by your row categories. You need to use this function to build a 

label for each combination of column categories in your crosstab. 
 

XTabGetColCount returns the number of columns generated by this input crosstab matrix. 
 

XTabGetRowCount returns the number of rows generated by this input crosstab matrix. 
 

In addition, Report Builder provides several functions that let you format the two- dimensional matrix generated by 

crosstab calculations. Apply these functions against the crosstab matrix. 
 

StrTabSeparate returns a string with a tab inserted between each word. You can use this function to tab separate 

each column of your crosstab matrix. 
 

StrTabColSuppress returns a string with repeating column values suppressed. It does not suppress repeating 

tabs. You can use this function with your crosstab matrix to suppress repeating column titles. 
 

StrTabRowSuppress returns a string with repeating row values suppressed. You can use this function with your 

crosstab matrix to suppress repeating row titles in your matrix. 
 

For more information on functions, refer to Chapter 5, Creating Formulas, or the Gupta online help. 

 

Assigning objec ts to pictures  
 

Use the picture object in Report Builder to display graphic images. You enable the Report, Format, Picture 

command when you select a picture object in your report template. If  you select multiple pictures, Report Builder 

disables the command. 
 

Use the Picture command in the Format menu to set the width, style, scaling, and contents of your picture object. 

You can also draw borders around the contents of the picture object. 
 

With the Picture command, you control the: 
 

Å Scaling of the picture. 

Å Graphic items imported into your report. 

Å Dimensions of your graphic. 

Pictures contain graphic items. You can assign one of three categories of information to a report picture object: 
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Å Static objects are any type of object that do not change in the report, from graphics to text blocks. You 

can copy graphic items to your report and place them in a picture. The graphics appear in both design and 

preview modes. 

Report Builder lets you import a number of different graphic formats, such as .BMP, .DIB, .GIF, .TIFF, 

.PCX, .WMF, and .JPG. 
 

Å Input objects are any input items with a data type of OBJECT. This information passes to your report 

from a SQLWindows application. 

Å Variable objects are any report input variables with a data type of OBJECT. This information passes to 

the report by a SQLWindows application. 

Static objects 
 

Report Builder accepts a large variety of graphic formats as input into your picture object. 
 

Importing a static object to your report 
 

1.    Choose your picture object and select Repor t, Format, Picture to open the Format Picture property pages. 
 

You can also right-click on the picture object, then select Properties from the context menu, to open this 

dialog box. 
 

2. Set the picture dimensions on the Appearance property page. You can also drag the borders of your picture 

object to resize it. 
 

 
 

 

 

 
3.    Accept the default Static option on the Picture property page. 
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This tells Report Builder that you are going to import an object, but are not going to link the template to the 

application in which the object was created. 
 

4.    Click the Paste From push button to open the Paste From dialog box. 
 

5. Select a file type from the Li st Files of Type list box at the bottom of the dialog box. 
 

This list box shows all the file formats you can import into your report template. When you select a file type, 

Report Builder lists all the files in that format under the File Name text box. 
 

6.    Select the file you want to import and click OK to return to the Format Picture dialog box. 

 

7.    Select the type of border you want to surround your object and click OK . 
 

Report Builder imports the contents of the selected file into your report. You can see this object in both design 

and preview modes of the report. 

Input  objects 
 

You can assign input items with an Object data type to your report picture objects. 
 

Assigning inputs to your picture object 
 

1.    Double-click the picture object to open the Format Picture dialog box. 
 

2.    Set your picture dimensions in the Appearance property page. 
 

3. Click Item in the Object group box to indicate that the content of this picture comes from an input item. 
 

4.    Select the input item you want from the appropriate drop down list box and click OK . 
 

5.    Report Builder assigns the selected input item to the picture object. 
 

You can see the contents of the picture object when you are in preview mode for the report. 

Variable objects  
 

You can assign input variables with an Object data type to your report picture objects. 
 

Assigning variables to your picture object 
 

1. Select your picture object and choose Format, Picture. 
 

2. Set your picture dimensions in the Dimensions group box. 
 

3. Click Var iable in the Object group box to indicate that the content of this picture comes from an input variable. 
 

4. Select the input variable you want from the appropriate drop down list box and click OK . 
 

5. Report Builder assigns the selected input variable to the picture object. 

You can see the contents of the picture object when you are in preview mode for the report.  
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Report Builder  Works pace 
The Report Builder workspace is the area where you create report templates. This chapter describes the following: 

 

Å Report work area and the object tree 

Å Rulers  

Å Menus and toolbars 

Å Viewing reports 

Å Report objects and how to modify them 

 

Report Builder work area and object tree  
 

When you create a new report template, you do so in the report work area. The work area appears initially with the 

following components: 
 

Å Report Header block caption 

Å Page Header block caption, with the data and column headings based on the query 

Å Detail Block caption with fields for the query data 

Å Page Footer block caption, with the page number 

Å Report Footer block caption 

Report Builder adds new header and footer block captions to the report template as you define break groups. The 

report work area is shown below. 
 

 
 

Report 
Window 

 

Object 
Tree 

 

 
 
 

Report 
Work Area 

 
 
 
 
 
 
 

 
The object tree displays all of the currently-defined report objects, such as: 

 

Å Input Items 

Å Input Variables 

Å Formulas 

Å Totals 

Å Crosstabs 

Å Break Groups 
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The object tree organizes the report objects into folders. It lets you list and display the properties of objects, and 

allows you to drag and drop objects into your reports. 

 

When it is displayed, the object tree appears in a frame to the left of the report window. You can define whether to 

display the object tree by selecting Object Tree on the View menu. 

 

To display the contents of a folder, double-click on the folder for the desired object. For example, to display all the 

currently-defined input items, double-click on the input items folder. 

 

To access a property page for an input item, input variable, formula, total, crosstab, or break group, select the item, 

click the right mouse button, and select Properties from the popup menu. 

 

To add an object to your report, position the pointer over the object that you wish to place into your report. While 

pressing the left mouse button, drag the object to the line on the report where you want it to be, then release the 

mouse button. 

Rulers  
Two rulers appear at the top of the workspace: 

 

1. The line ruler displays the margins and paper size of your report. This ruler is only displayed if ruler is 

checked in the view menu, and you are in Report Design mode. 

 

2. The tab ruler shows the width of the currently-selected field or background text object. Tabs for a field can be 

changed by manipulating the graphical tab icons on the tab ruler. This ruler is only displayed when a report 

object is selected in the design layout and tab ruler in the view menu is selected. 

 

The rulers are shown below. 

 

Line Ruler 

 
Tab Ruler 

 

 

Line ruler 

This ruler displays the margins and paper size of your current report. The top border of the ruler li ne also displays 

the grid increments when the Grid is on. 
 

When you drag a Report Builder object across a line, Report Builder displays a black box in the Ruler Line. This 

black box has the same width and location as the selected Report Builder Objects ruler to precisely position Report 

Builder objects in your Report Builder template. 

 

Tab ruler 

When enabled from the View menu, the tab ruler displays in the bottom half of the Report Builder ruler. You can set 

and control the tabs for a field by manipulating the graphical tab icons on the tab ruler. The tab ruler also shows the 

width of the currently-selected field or background text object. 
 

The tab ruler is an alternative to using the Repor t, Format, Tabs property page. Double-click on any tab icon to 

open the Report , Format, Tabs property page. 

Note:  The tab ruler will not appear unless the line ruler is also selected. 

 

When you select a field or background text, the tab ruler shows the size of the field, all the tabs that are assigned to 

it, the tab justification, and the width of each tab. 
 

Each tab icon (shown at the left) is made up of a: 
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Head (pointed arrow). The tab head shows the beginning of the tab. Click and drag the head to change the starting 

position of the tab. Normal tabs have a single arrowhead and are shown in black. A master repeating tab has a 

double arrow head and is shown in a bright blue color. All  subsequent representations of repeating tabs are shown 

with a truncated arrow head, a gray color, and cannot be directly modified. 
 

Body (straight li ne). The tab body shows the width of the tab. Click and drag the tab body to move the tab to a new 

location without changing its size. 
 

Tail (right angle). The tab tail shows the end of the tab. Click and drag the tail to change the ending position of the 

tab. 
 

Justification Icon. The tab justification icon is a small arrow within the tab body. This arrow can point right (right 

justif ied), down (center justified), or left (left justif ied). 
 

To add tabs, left click on the tab ruler to add a new tab in this field. By default, Report Builder always inserts a left 

justified repeating tab. 
 

To delete tabs, select a tab icon and drag it off the tab ruler to delete that tab. 
 

To repeat tabs, ctrl-right click on a tab to toggle repeating tabs on and off. Repeating tabs are shown in bright blue 

with a double arrow head. All  new tabs are created as repeating tabs by default. 
 

To change tab justification, click the right mouse button over an existing tab. This is an easy way to change the 

justification (right justified, left justified, and centered) of a tab. 
 

To size and position the tab, drag the tab head towards the tail of the preceding tab. Report Builder shrinks the size 

of the preceding tab to make room for your change. When you drag the tail of a tab towards the head of the next tab, 

Report Builder pushes all subsequent tabs to the right. This does not cause resizing of subsequent tabs. 
 

To view or hide the tab ruler, choose the View Tab Ruler  command to view or hide the tab ruler. A check mark 

beside this command indicates that the tab ruler is currently selected. 

Menus and toolbars  
As you design your reports, you can execute commands from the menu bar, context menus (the pop-up menus that 

appear when you click the right mouse button), and toolbars. The menu bar contains the five available pull-down 

menus and their commands. 
 

For example, the Edit menu has commands that let you cut, copy, and paste text or other objects. There are also 

keyboard shortcuts listed beside many of the commands. 
 

You may press Esc at any time to exit both the menu and the menu bar. You may get on-line help by doing either of 

the following: 
 

Å     Select Help, Contents or, 

Å     Press F1 to see the help for that command or dialog box. 

The Report Builder toolbar provides 13 of the most common functions to make it more convenient to design 

reports. It may be turned on or off from the View, Toolbars menu and moved anywhere on the screen. The Report 

Builder toolbar is shown below. 
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Á New Report creates a new report and prompts you to define a query for the report. 

Á Open Report opens an existing report or query 

Á Save Report  saves the current report to a fi le. The saved report has a default file extension of .CQT. 

Á Cut removes a selected object from the Report Builder template and places it in the Clipboard. This 

command works only when an object is selected. 

Á Copy copies the selected object from the Report Builder template to the Clipboard. This command works 

only when an object is selected. 

Á Paste inserts the contents of the Clipboard at the insertion point in the current report. 

Á Copy SQL copies the SQL generated by the query to the clipboard. 

Á Print  sends the current report to the printer. 

Á Import  imports a template. 

Á Export  exports a template. 

Á Define Query opens the Define Query property page. 

Á Toggle Mode switches between the Report Builderôs design and preview modes. 

Á Zoom enlarges or reduces the size of the report. This command is available only in preview mode. 

 

Tools toolbar 

As you develop your report template, you add objects such as boxes, fields, lines to the work area. The Tools 

toolbar allows you to add these objects to your template. Like the Report Builder toolbar, the Tools toolbar can be 

turned on or off from the View, Toolbars menu and can be moved anywhere on the screen. The tools and 

commands on the Tools toolbar are also available in the Report , New menu. The Tools toolbar is shown below. 
 

 
 

Å     Select Tool selects objects in the Report Builder template 

Å     Background Tool enters background text in the template. 

Å     Field Tool draws fields in the template. 

Å     Box Tool inserts new boxes in the template. 

Å     PictureTool adds new picture objects to your report. 

Å     LineTool adds lines to the template. 

Å     Graph Tool inserts a graph into the template. 

Å     Crosstab Tool inserts crosstabs in the template. 

Å Reset Cursor automatically causes Report Builder to return to the selector tool after each use of another 

tool. 
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Note:  The Tools toolbar is available only in design mode. 

 

Context menus 

If  you click the right mouse button over a report object, a context menu appears. The context menus provide a copy 

of the same commands you would see if you pulled down a menu from the menu bar. The example of a context 

menu you will  see in design mode is shown below. In this example, the Field tool is being selected. 
 

 

 
 

Viewing your report  
 

View your report either in design mode or in preview mode. Each new report template begins in design mode. 

Preview mode shows you how your report appears when it is printed. 
 

Design mode 
 

Design mode displays your report template, so that you can add lines, fields, boxes, and graphics to your report 

layout by using tools from either the Report or context menus, or the Tool toolbar. You can also include input 

items, formulas, break groups, and other report elements by using the object tree. 
 

A report in design mode is shown below. This same report is shown in Preview mode on page 3-11. 
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To view different parts of the work area, use the vertical or horizontal scroll bars, or press the Page Up or Page 

Down key to view different parts of the window. 
 

Each template shows block caption bars and objects associated with each block group. Many menu commands in 

the Report menus are enabled in design mode and disabled in preview mode. 
 

The design window is independent of your data source, so you can design your report template before linking data to 

the report. 

Preview  mode 
 

In preview mode, you cannot modify the layout of the report or change any of the report inputs; you can only see 

how the report looks when it contains data. 
 

Viewing your report in preview mode 
 

1.    Select Report, Report Preview. 
 

The report work area is replaced by the report. If  you are linked to a query, the data appears in the window. The 

graphic below shows the preview mode of the report shown in Design mode on page 3-10. 
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2.    Select Report,  Report  Design to return to the design window. 
 

Use preview mode to see what your report looks li ke when it prints. Because you cannot edit a report in preview 

mode, the report ruler disappears and the commands that effect the design and layout of the report page are 

disabled. 
 

The First, Next, Previous, Last, and Goto commands in the View menu, are active only in preview mode to view 

different pages of the report. These commands are also available from the Scroll toolbar. 

 

Scroll  toolbar  
 

In Report Preview, you can select the Scroll  toolbar from the View, Toolbars menu. The Scroll toolbar is shown 

below. 
 

 
 
 
 
 

  First Page                              Go To Page 

            Previous Page         Last Page 

  Next Page 

 

The arrows let you page through the report. They correspond to the First, Next, Previous, Last, and Go To Page 

commands in the View menu.  

First  Page displays the first page of the current report.  

Previous Page displays the previous page of the current report.  

Next Page displays the next page of the current report. 

Last Page displays the last page of the current report. 

Go to Page allows you to select and go to any page in the current report. 

Note:  The Last Page arrow or command may take some time to execute if you are working with a large amount of 
data. 
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Report objec ts 
 

Each element in the report template is an object. Some objects are: 
 

Å Background Text, such as page headers and footers, column headers, and labels of other objects. 

Å     Lines, in headers, footers, or detail blocks. 

Å     Fields, containing content for report inputs, li teral text, and formulas. 

Å     Boxes that surround groups of fields or entire blocks. 

Å     Pictures, containing graphics or other objects 

Å     Graphs, containing business charts. 

Å     Crosstab Reports to display two-dimensional matrices of report data. 

You create report objects with the object tools in the Report or context menu, or the tool toolbar. Use the Format 

property pages to modify the format for many of the report objects. 
 

Background  text  
 

Use the background text tool to enter literal text in your report template. You can use background text to label: 
 

Å     The objects in your report template. 

Å     Column headers for the input items in your detail block. 

Å     Report and page headers and footers. 
 

Inserting a background text object 
 

1. Select the Background Text command from the Report, New menu, the context menu, or background text tool 

from the Tool toolbar. 
 

The pointer changes to the background text icon. 
 

2. Place the tool where you want to add a static label and press the left mouse button to insert the new object. 
 

3.    Enter the label information and press Enter. 

Note: Entering literal text in a field, with single quotes around the text, provides the same result as using the 
background text field. 

 

You can format background text with character formats such as bolding, italics, underline, strikeout, fonts, sizing, 

borders, tab setting and alignment. You can apply many of these options using the objectôs property page. 

Rich Text  
A rich text control can be populated with text of various colors, styles, sizes, fonts, etc., as well as images. 
 

Inserting a Rich Text object 
 

1. Select Rich Text from the Report  menu, Tool Box section. The pointer changes to the rich text icon. 

2. Place the tool where you want to add a Rich Text field and press the left mouse button to insert the new object. 

3. Enter the data source and press Enter. 

 

Changing Rich Text Properties 
 

1. Choose the Select Tool from the Report menu, Tool Box section. 

2. Right-click on the Rich Text object. Make sure the object is selected, and not the text within the object. 
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3. Select Properties.  

The Properties dialog box will  display. Change properties as desired. 

 

Lines 
The line tool lets you insert new lines into the report template. There are four ways to insert new lines: 
 

Å    Use the Line tool in the Tools menu. 

Å     Use the Insert Line command from the Tools menu. 

Å     Select a block caption and press the Insert key. 

Å Select any item and press the Insert key to add a line to the bottom item selected. 

Apply formatting to any line by using the Line command from the Report Format menu or by right clicking a line 

and choosing Properties with the selector tool to open the Format Line dialog box. 

Note:  Normally the Report Header block prints at the top of page one, and the Page Header block prints at the top 
of all subsequent pages. However, if there are no lines present in the Report Header block, the Page Header will 
print at the top of page one. 

 

Inserting a line using the line tool 
 

1. Select the line tool from the Report, New menu, the context menu, or line tool from the Tool toolbar. 

The pointer changes to the line tool icon. 
 

2. Place the line tool where you want to add the new line. 

To insert a new line above a line, click above the center of the line. To insert a new line below a line, click below 

the center of the line. 
 

3. Press the left mouse button to insert the new line. 
 

4. Continue inserting lines as necessary. 
 

Deleting a line 
 

1. Choose the selector tool, either from the tool palette or the Tools menu. 

The pointer changes to the selector tool. 
 

2. Select the line you want to delete from the report design window. 

To select more than one line, press and hold the Shift key as you click successive lines. To select all lines in a 

block, hold down Ctrl  and click on the caption block. To select a line under other objects, press CTRL  and left-

click. 
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3. Select Cut from the Edit  menu, press Ctrl+x , then press the Delete key. 

Report Builder deletes the selected line, and all the objects on the line. 

Fields 
Use this tool to create the fields in your report. Every field must contain content of one of the following types: 
 

Å     Report inputs, including input items, variables, totals, and crosstabs. 

Å     Literal  strings, created by entering text directly into the field inside single quotes. 

Å     Formulas created using the Formula Editor and assigned from the object tree. 
 

Inserting a field into the report template 
 

1. Select the field tool from the Report , New menu, the context menu, or from the Tool toolbar. 
 

2. Position the pointer where you want the field to appear and click the left mouse button. 

Use the vertical line in the ruler to position the field on the line. Report Builder always creates new fields with 

dynamic width. Change the field size using the mouse. 
 

3. To enter the field content value, enter the text you want in the field using single quotes around the text. 

You must enclose all literal text entries within single quotes. You can assign report inputs or existing formulas 

by selecting them from the object tree, then dragging them to the report. 

Note: Using the background text field provides the same result as entering literal text in a field. 

4. Press Enter to save the new contents of the field. 

The field remains selected until you click elsewhere in the report window. 
 

Resizing a field with the resizing cursor 
 

1. Position any tool over the right or left edge of the field. 

The cursor changes to the two-headed arrow so you can now resize the field. 
 

2. Click and drag the edge of the field to change its width. 

As you drag, a vertical line in the ruler shows your exact position. 
 

3. Release the left mouse button when the field is the desired width. 
 

4. Repeat Steps 2 and 3 for the opposite edge if you want to resize the other side of the field. 
 

5. Click anywhere outside of the field to deselect it. 
 

Deleting a field 
 

1. Select the selector tool. 
 

2. Select the field you want to delete from the report template. 

Press Shift+Click  to select multiple fields. 
 

3. Select Edit, Cut, press Ctrl+x , or press the Delete key to remove the selected field. 

Boxes 
 

Create boxes around a group of fields or an entire block using the box tool. Use the Format Box dialog box to 

move, resize, and reformat the boxes. Right click on a box to open the Format Box dialog box. 

 

Boxes are fixed in size. If  the text inside a box grows, the box does not automatically grow to accommodate the 

extra text. If  you want a box around a field with a dynamic width or with line wrapping, use field borders instead 

of boxes. 
 

Creating a box 
 

1. Select the box tool from the Report, New menu, the context menu, or from the Tool toolbar. 
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2. Position the pointer where you want the starting corner of the box. 

The box must be within the boundaries of the block, so you must start drawing from within a line. 

3. Click and drag the mouse, holding down the left button, to create the box. 

Report Builder displays an outline, showing the size of the box, as you drag. When you release the mouse, the 

gray outline is white and the box is fil led until  you select another object on the template, or click anywhere 

outside the box. 

 

Resizing a box with the resizing cursor 
 

1. Position any tool over the edge of the box to be resized. 

The cursor changes to the horizontal, two-headed arrow so you can resize the box. 

2. Drag the edge of the box to enlarge or reduce its size. 

3. Click anywhere outside of the box to deselect it. 

 

 

Deleting a box 
 

1. Select the selector tool. 

2. Select the box you want to delete from the template. 

Press Shift+Click to select multiple boxes. 

3. Select Edit, Cut, press Ctrl+x, or press the Delete key. 

Report Builder deletes the selected boxes. 

Pictures  
Create picture objects in your report template by using the picture tool. Picture objects contain graphic images. 

 

Use the Report, Format, Picture... dialog box to move, resize, or reformat a selected picture. Right click the picture 

object to open this dialog box. You can assign static objects, input items, or input variables with an object data type 

as its contents. 
 

Creating a picture object 
 

1.    Select the picture tool. 

 

2.    Position the pointer where you want the starting corner of the picture to begin. 

 

You must place the picture within the boundaries of the block, so draw the picture from within a line. 

 

3.    Press and drag the mouse, holding down the left button, to create the picture. 

 

Report Builder displays a gray outline, showing the size of the picture, as you drag. When you release the mouse, 

the gray outline is white and the picture is filled. 

Graphs 
Graphs in Report Builder provides the following business graphics functionality: 

 

Å     True 3D graphs 

Å     Statistics and curve fitting 

Å     Formulas for the graph titles 

Å     Elevation, rotation, and perspective control 

Å     Font control over titles and labels 

Å     Color controls for graph elements and backgrounds 

Å     Axis styles 
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Å     Grid styles and control 
 

Creating a graph object 
 

This procedure shows you how to create and format a graph in your report. 
 

1.    Use the line tool to add several lines to the Detail Block. 
 

2. In the design window, click the graph tool on the tool palette and drop a graph object on your report. 
 

The graph control window on your report displays a sample graph with a tool bar above it. 

 

 
 

3. Right click on Graph control and then click on Properties menu item and then click on "QuickGraph 

Properties" button to open Quick Graph property dialog box. 

Note:  You can access other property pages with the other toolbar buttons, but only the "magnifying glass" 
button allows you to access the Data Source tab, which MUST be customized first in order for other property 
changes to take effect. 

4.    Before making any other changes in the graph, select a data source in the Data Source tab: 
 

5. After you have chosen a data source, use the two Labels tabs to indicate which input items you would like on 

each axis. 
 

6.    Customize the graph according to your preferences. 
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Crosstab reports  
 

Use the crosstab tool to open a wizard to help you create a crosstab in your report. Before creating your crosstab, 

you must define the input item names in the same order they appear in the data sourceôs input rows. 
 

Creating a crosstab object 
 

1.    Define the input items in the Format Input Items dialog box. 
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2.    Add a line in the Report Footer block. 
 

3. Select the crosstab tool and click the tool on the line in the Report Footer block to open the crosstabs wizard. 

All  the inputs you defined in Step 1 are listed in this wizard. 
 

 
 
 

4.    Enter data for each step of the wizard and click Next to move on to the next step. 
 

The wizard asks you for the row, column, and cell values. In addition you will define the statistic the crosstab 

uses. (Sum is the default.) Select summary statistics, column and row headings, and name the crosstab. 
 

5.    Click OK when you are at the Final step to add the crosstab object to the Report Footer block. 
 

Report Builder adds a crosstab icon and the name of the crosstab in the crosstab object. 
 

6.    Click OK . 
 

7.    Select Report, Preview to preview the data in your crosstab. 

Moving  report  objects 
 

All  mouse cursors become the move cursor when they are placed over a moveable object in the design window. 
 

The only exception is when you have just created a new field. In that case, the cursor remains an insertion point 

until you enter text, choose a report input (literals, variables, cross tabs, or totals) or formula, or press Enter. 
 

Moving a report object 
 

1. Select the object you want to move. 
 

Press Shift+Click  to select multiple objects. The cursor changes to a four-headed arrow indicating that you can 

move the object in any direction. 
 

2. Drag the object to another position within the same report block, or use Cut and Paste commands from the 

Edit  menu to move an object to another block. 
 

3. Release the mouse button and click anywhere to deselect the object. 
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Cutting,  copying,  or  pasting report  objects  
 

Cut, copy, or paste any report object by using the commands in the Edit  menu. For example, you can move a field 

from one block to another or paste it in more than one place. You can also change the field after you have cut, 

copied, or pasted it elsewhere in the report template. 
 

Watermarks  
 

You can place a watermark in the background of your report by clicking "Water Mark" in the Report Menu. In the 

dialog box that is displayed, select whether you would like No Watermark (default), a Picture Watermark, Input 

Item/Variable or a Text Watermark. You can also specify condition formula to determine whether show watermark 

or not. 

 

 

Picture  Water mark  
 

You can use any of the following file types as the source for a picture watermark: BMP, DIB, GIF, TIFF, PCX, 

WMF, and JPEG. To select a file, click "Paste From" in the Report Watermark dialog box, select the file type, and 

then select a file. 
 

By default, the image is resized to fit  in the background of the report. If youôd rather specify a size (in percentage of 

the original file dimensions), choose from the "Scale" dropdown list. 
 

The image will  automatically be faded slightly. Check the "Washout" checkbox if  you would like the image to be 

faded more noticeably. 






































































































































































